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Discontinuations

Discontinuation of Windows® 10

Microsoft® has discontinued support for the Windows® 10 operating system in October 2025. For com-
patibility reasons, HiCAD 2025 SP2 and HELiOS 2025 SP2 were the last versions of our CAD or PDM system to
support Windows© 10. HiCAD 2026 and HELiOS 2026 no longer run under Windows© 10.

Discontinuation of various HiCAD modules

Starting with HiCAD 2026 (Version 31.0), the following HiCAD modules will no longer be supported:

n HiCAD classic and HiCAD creator

The extension modules that previously required HiCAD classic or HiCAD creator now require HiCAD solu-
tion. Customers with a maintenance contract for one of the two modules will automatically receive HiCAD
solution when they update.

n HiCAD Sheet Metal suite

Customers with a maintenance contract for HiCAD Sheet Metal suite will automatically receive Sheet Metal
suite premium when they update.

n Metal Engineering suite classic

Customers with a maintenance contract for HiCAD Metal Engineering suite classic will automatically receive
HiCAD solution when they update.

n Report Manager professional

The additional functionality of the Report Manager professional has been integrated into the Report Man-
ager.

From HiCAD 2026 onwards, the following change to the module structure applies:

n Steel Engineering suite premium

The extension module Sheet Metal professional has been integrated into the Steel Engineering suite
premium.

Discontinuation of "old" OpenGL versions

From HiCAD 2021 on, only OpenGL version 4.3 is used in all HiCAD modules. Until now this was only the case
with the module HiCAD Point Cloud. This means that HiCAD 2022 can no longer be run on computers without
a separate graphics card. To avoid possible problems with onboard graphics cards, we recommend using a
stand-alone graphics card.

Discontinuation of the "old" Create detail drawing function

With the release of HiCAD 2012, the previously valid workshop drawing functionality in Steel Engineering had
been extended to a function for general drawing derivation. The previous functions for detail drawings in Steel
Engineering were still available in the Detail drawing section of the Drawing menu. As of HiCAD 2022 (Version
2700.0) these functions are no longer supported.
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Discontinuation of HELiOS 32 Bit, HiCAD Viewer 32 Bit and Office Interface 32 Bit

Since HELiOS 2022 (Version 2700.0) there is no 32 Bit version available for HELiOS and the HiCAD Viewer.
Since Microsoft has also offered a 64 Bit installation of Office since Office 2010 and many add-ins for Office are
now also available as 64 Bit versions, with HELiOS 2024 we will support an Office interface only for a 64 Bit
Office. If you are still using the Office interface in conjunction with a 32 Bit Office, you must uninstall your Office
version and reinstall it as a 64 Bit version as soon as you update to HELiOS 2024.

Discontinuation of CADENAS PARTdataManager

As of HiCAD 2022 SP2, the CADENAS PARTdataManager will no longer be supported. Thus, the functions
Insert main part, PARTsolutions (CADENAS program) and Import PARTsolutions part will no longer be available
from SP2 onwards.

Discontinuation of 3-D projection grid

As of HiCAD 2023, the 3-D projection grid function is no longer available.

Discontinuation of Microsoft SQL Server 2012 and 2014

Microsoft® discontinued support for SQL Server 2012 in July 2022 and no longer provides security updates. As
a result, SQL Server 2012 will no longer be supported from HELiOS 2025 onwards.

Also, Microsoft® discontinued support for SQL Server 2014 in July 2024. Therefore, SQL Server 2014 will no
longer be supported from HELiOS 2026 onwards.

Discontinuation of the "old" Report Manager

From HELiOS 2024 onwards, the "old" Report Manager, i.e. the Report Manager up to 2022, will no longer be
delivered with a standalone installation of the HELiOS Desktop. In a HiCAD/HELiOS installation or a HELiOS
update of HiCAD, however, the "old" Report Manager is still included. From HiCAD 2025 onwards, only the
"new" Report Manager as of 2023 will be supported.

Discontinuation of Part insertion v26 (PE)

The old Part insertion function in Plant Engineering has now been completely replaced by the new Part inser-
tion function. Therefore, the function Part insertion v26 in Plant Engineering is no longer available as of HiCAD
2024 SP1.
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Basics

Major Release

New Ribbon

The Ribbon has been modernised. In addition to a new design, the new Ribbon supports the use of 4K screens. This
prevents scaling effects that could previously occur on icons when using high-resolution screens.

The QuickAccess toolbar is now located below the ribbon by default. The pull-down menu of the QuickAccess tool-
bar with configuration options has been replaced by a context menu that you can access by right-clicking on an
empty space on the ribbon.

To start the UserInterfaceEditor.exe tool, which you can use to configure the QuickAccess toolbar and create your

own ribbons, click on the icon in the upper right corner of the ribbon and activate the Customize UI function.

BOM-relevance of auxiliary and environment parts
Auxiliary and surrounding parts are often included in the drawing, but should not normally appear in BOMs.

If the BOM-relevance of already itemised parts is changed subsequently, this can lead to inconsistencies in the item
numbers and texts, as described in the example Itemisation - BOM-relevance of itemised parts under Further notes.

For this reason, from HiCAD 2026 onwards, the procedure of creating auxiliary and surrounding parts outside the
main assembly is supported. The following changes have been made for this purpose:

In the Itemisation with options dialogue window, the Only within the main assembly option has been added to
the Numbering section of the General tab.

The Only consider parts within the main assembly checkbox has been added to the General section of the Bill of

materials dialogue window.

Two default settings have been adjusted in the Configuration Editor:

n The referencing setting for the BOM-relevant attribute at System settings > Attribute management > Attributes
has been changed from "Do not transfer" to Standard behaviour.

n At Modelling > Change part structure, the Move parts out of main assembly checkbox is now enabled by default
for all industries. Previously, this was only the case for Steel Engineering.

News Overview
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Hide surfaces
The ALT key has been assigned the function of hiding surfaces of 3-D parts to make the facets underneath visible.
To do this, move the cursor over the desired surface and press the ALT key. This works in every mode and during
every function, even if the function does not require surface selection. The CTRL + ALT key combination shows the
last hidden surface again. After exiting the respective mode in which the surfaces were hidden, all surfaces are auto-
matically shown again.

An overview of the keyboard layout in HiCAD can be found here.
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Attribute Management

Automatic calculation and manual entry of attributes

Certain attributes in HiCAD, such as weight, surface area, volume, length and width, can be calculated auto-
matically. Until now, automatic calculation of attributes could be disabled by activating the %WFIX attribute via the
Weight fixed checkbox in the attribute mask. The %WFIX attribute and the checkbox have been removed. Instead,
you can now individually set for each part and each attribute whether it should be calculated automatically or
entered manually. To do this, right-click on the field behind the corresponding attribute in the attribute mask or in
the ICN properties window. In the context menu that appears, select the option Set attribute manually or Set attrib-

ute automatically. Manually changed attributes will then be indicated with this symbol .

When loading old drawings in HiCAD 2026, the attribute %WFIX continues to be evaluated and affected sub-attrib-
utes are set to Set attribute manually. In the Configuration Editor, the attribute %WFIX then becomes an internal sys-
tem attribute.

Further settings for attribute calculation can be found in the Configuration Editor at System settings > Attribute man-
agement > Attribute calculation.
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Up-to-dateness of calculated attributes

In the Attributes mask and in the Properties window of parts, icons in the fields of calculated attributes indicate the
up-to-dateness of the calculation. The following statuses are distinguished:

n
Automatically calculated, Current

n
Automatically calculated, Outdated

n
Automatic calculation is locked

n
Manual entry

n
Different statuses (occurs when several different parts are selected in the properties window)

A description of the status is displayed as a tooltip when you move the cursor over the respective icon.

In order to identify parts with invalid attributes, the Design Checker in the General category has been expan-
ded to include two tests: Parts with manually overwritten attributes and Parts with outdated attributes.
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Apply changes without restarting

Changes to the attribute management in the Configuration Editor under System settings > Attribute management >
Attributes will be applied immediately in HiCAD 2026 and later, without having to restart HiCAD. Previously, the
attributes were read from the Configuration Editor once when HiCAD was started. With the new version, the attribute
list is checked for updates when each function that offers attribute selection is started and reloaded if necessary.
This affects:

n the Text Editor

n the Attribute mask

n the P+ID attribute assignment.

The ICN properties window is updated when the part is changed.

Hiding internal HELiOS attributes

In attribute selection masks such as the Annotation Editor, internal HELiOS attributes are now hidden in addition to
internal HiCAD attributes.

So-called internal attributes are HELiOS system attributes that are generally not relevant for end users when sorting
result lists. They are therefore subtracted from the display in the attribute configuration by default, but can be
included by deactivating the checkbox.
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Drawing derivation

Annotation of sub-parts depending on part type

The Drawing > Itemisation/Detailing > Derive... > Templates > Edit part annotation templates function allows
you to edit the annotation templates for individual parts and assemblies that are used for part annotation in work-
shop drawings. When selecting a Usage-dependent configuration other than the Default settings, only three dif-
ferent flag types were previously available: for individual parts, assemblies/main parts and sub-parts. The selection
of flag types for sub-parts has been expanded. Starting with HiCAD 2026, you can specify different annotation set-
tings for the following sub-parts:

n Sub-parts, General

n Sub-parts, Profile

n Sub-parts, Plate

n Sub-parts, Sheet.

The settings are saved in an FTD file.

If an FTD file for sub-parts was changed before HiCAD 2026, the changes will be overwritten in the FTD file for gen-
eral sub-parts when updating to the new version and will no longer apply to sub-parts of the type Profile, Plate or
Sheet. In workshop drawings created before HiCAD 2026 and subsequently edited, the part annotation may change
in such a case.
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Dimensioning rule 57: Deleting duplicate dimensions

When dimensioning overlapping sub-parts and standard processings perpendicular to the screen plane by meams
of Dimensioning rule 57, double chain dimensions may occur in workshop drawings. To change this behaviour, the
parameter DELIDENTICSUBPARTCHAINS has been added to the STW_DIMSETTINGS.XML file in the HiCAD SYS
directory. If the value is set to 1, double dimensions are checked when workshop drawings are created using dimen-
sioning rule 57 and deleted if found.

If the parameter DELIDENTICSUBPARTCHAINS does not yet exist in the STW_DIMSETTINGS.XML file, it must be
deleted manually once and HiCAD restarted.

Here you will find an overview of the dimensioning rules and information on the parameters of the STW_
DIMSETTINGS.XML file.

Please note that the new parameter only affects Dimensioning rule 57.
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View orientation

During drawing derivation of assemblies whose part orientation was not determined manually but via the part
coordinate system of the main part, a deviation occurred when generating the front view. Compared to the front view
determined by the part orientation, it was rotated by 90 degrees.

This behaviour has been changed, so that the front view created matches the front view of the part orientation. Draw-
ings created before HiCAD 2026 that contain the described deviation will not be corrected during further pro-
cessing, irrespective of the presetting.

In the Configuration Editor, under Compatibility > Automatic drawing derivation, the View orientation of general parts
and assemblies list box has been added to maintain the old behaviour for new drawings.

The following options are available:

n Front view = -Y (new behaviour, default setting)

n Front view = +Z (old behaviour)

New and old behaviour when deriving the front view of the assembly HEA 200
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Optimised closing of all drawings

The query dialogue that appears when you call the Close all drawings has been extended to include the Apply
to all drawings checkbox. If this checkbox is selected, you will not be asked whether you want to save changes for
each drawing individually.

Shaded with Hidden Line

The icon has been changed so that the Shaded with Hidden Line view mode in the QuickAccess Toolbar is

more clearly distinguishable from the Shaded with edges (3-D) quick view mode. In addition, when the
Shaded with Hidden Line is activated, a message now appears informing you of possible longer waiting times that
may result from hidden line calculations.

Hide internal HELiOS attributes
In attribute selection masks such as the Annotation Editor, the internal HELiOS attributes are now hidden alongside
the internal HiCAD attributes.

So-called internal attributes are system attributes of HELiOS that are generally not relevant for the end user when
sorting result lists. They are therefore subtracted from the display in the attribute configuration by default, but can
be included by deactivating the checkbox.
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Display the last drawings used in the Start Centre

The Last used drawings area in the Start Centre dialogue has been divided into the History and Favourites
tabs. The star icon in the upper left corner of the preview image can be used to save or remove recently used doc-
uments from the History as favourites. This allows you to always access specific documents immediately, regardless
of when they were last opened. Only a maximum of 16 documents are displayed in the History.
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Renewal of the Switch drawing window
The Switch drawing has been redesigned. It is now possible to open 96 drawings simultaneously. In addition, you
can close a drawing by clicking the X in the upper right corner of the thumbnail. A HiCAD or HELiOS icon is dis-
played in the upper left corner of the thumbnail. This icon makes it easier to assign drawings. When you point the
cursor at a thumbnail, a preview of the corresponding drawing is displayed.

Reset view rotation with ESC
n If you dynamically rotate views using the middle mouse button (2-button mouse: both buttons) of the standard

mouse, you can reset the view using the ESC key. To do this, you must hold down the mouse button.

n When you rotate a view using the SpaceMouse®, you can reset the view to its original position using the ESC key
as long as you do not move the standard mouse. This requires that:

l Auto mode is disabled(SpaceMouse® button: Menu > Advanced Settings > Tab: Rotation Center), and

l in the HiCAD Configuration Editor under System settings > Miscellaneous, the option End SpaceMouse
mode by moving the mouse has been activated.
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2-D

Major Release

Sub-attributes in annotation tags
Since HELiOS contains nested Attributes, i.e. attributes that contain further data, these sub-attributes can now be
selected in the function 2-D Dimensioning + Text > Text > New > New text block.

Examples of such attributes are customer and material.

Customer

n Name

n Customer number

n Phone number

Material

n Designation

n Density

These can be found in the 2-D text block dialogue window under Attribute...:
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3-D

Major Release

Planning grid: Draw grid lines

The Planning grid has been extended to include the option of drawing grid lines over a sketch.

The button in the newly added Additional drawn axes area temporarily closes the Planning grid dialogue win-
dow and displays the Process sketch menu. You can then insert your own lines using the functions in the Sketch >
Draw area and assign them a direction (X or Y) using the Process sketch menu. The following applies to the grid
lines drawn:

n Individual straight lines, arcs and arc segments are permitted.

n The sketches can be edited with the Sketch HCM.

The lines are automatically sorted into the respective axis table and marked with the comment Drawn. This can be
corrected afterwards using the arrow keys.

The projections set for the generated grid lines are not applied to the drawn lines.

The number of axes in the X and Y directions is displayed in the Additional drawn axes area. If no direction has been
assigned to a drawn line, an error message appears there.
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Revision of the "Show/hide elements in view" dialogue

To improve the clarity of the Show/hide elements in view , several changes have been made:

The meaning of the icons has been changed. The following options are now available for the visibility of elements:

n
Display normally and hide in Hidden Line mode,

n
Hide,

n Display and do not hide in Hidden Line mode.

When you start the dialogue for the first time after updating to the new version, a message will be displayed inform-
ing you of the change.

In the Configuration Editor, under Drawing > Views, the Hiding and overlapping of edges area has been renamed to
Show and hide elements. Here you will find the default settings or the dialogue window. The names in this area have
been largely aligned with the names in the dialogue. This also applies to the names under System settings > Visu-
alisation > Views > Insertion view.

Standardisation of surface and plane selection
Surface selection has been standardised for all functions in the 3-D Standard and 3-D FFS areas. With the new sur-
face selection, surfaces are completely highlighted with their edges as soon as you move the cursor over them and
can be selected using the LMB.

You can use the ALT key to hide the surface under the cursor. This allows you to select hidden surfaces without hav-
ing to rotate the drawing or change the view. The key combination CTRL + ALT shows the last hidden surface again.
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It is still possible to select a surface across two edges, as was previously the case with some functions. To do this,
move the cursor over a single edge and wait until only the single edge is highlighted before selecting it. You will then
be prompted to specify a second edge to completely define the surface.

It is still possible to select a surface across two edges, as was previously the case with some functions. To do this,
move the cursor over a single edge and wait until only the single edge is highlighted before selecting it. You will then
be prompted to specify a second edge to completely define the surface.

The selection has also been standardised for all functions that require a plane to be selected. This is now done in the
same way as when creating a processing plane.

Shaded with Hidden Line

To make the Shaded with Hidden Line view mode in the Quick Access Toolbar more distinct from the

Shaded with edges (3-D) quick view mode, the icon has been changed. In addition, when the Shaded with
Hidden Line mode is activated, a message now appears informing you of possible longer waiting times that may res-
ult from hidden line calculations.
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Standard processings

The dialogue window Bores, Countersinks, Threads function for creating standard processing operations
has been expanded:

Creating user-defined forms

The User-defined form has been added. The new Form provides access to sample tables from the Bore patterns
and Punching tools catalogues, where you can save your user-defined bores as sketches.

In order to use your sketch as a bore pattern, it must be parameterised with the Sketch HCM and then saved in KRA
format. It is also possible to create the bore as a 2-D part and save it in DCF format. However, we recommend using
the sketch variant, as it offers significantly higher quality advantages.

The new table Rectangle (filleted) has been added to the Bore patterns catalogue and the new table Keyhole has
been added to the Punching tools catalogue. These each contain an ISD-side example.

The User-defined form replaces the old functions Bore pattern and Punching tools . The old func-
tions can currently still be found under 3-D Standard > Standard Processings > Bore/Thr. > Up to HiCAD 2025 or
under Sheet Metal > Further tools > Moulding tools > Up to HiCAD 2025.
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Bore depth and grid

Bore depth

The option To point is now available as an additional mode for specifying the Bore depth. By selecting a point, the
new option allows you to determine the end of the hole. In addition, you can specify a distance from the end of the
bore tip to the point.

When specifying the Bore depth above a certain value using the With drilling depth mode, an arrow pointing in the
direction of the bore is displayed in the preview, starting from the tip of the bore. By dragging the tip of the arrow with
the cursor, the Bore depth can be changed manually afterwards. To distinguish this arrow from the arrows that mark
grid positions where the part is not hit, the colour of those arrows has been changed.

Furthermore, the settings made for the Bore depth remain unchanged when changing the Form, as far as this is
reasonably possible.

The Perpendicular for laser cutting option is now also available when the bore depth is set to Through. Previously,
this option was only available in Next exit surface mode.

Grid

If Radial mode is selected in the Grid configuration window while the current processing plane is tangential to a cyl-
inder surface, the cylinder surface is now automatically marked as the new processing plane. The same applies if a
plane tangential to a cylinder surface is already selected and then switched to Radial grid mode.
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Apply standard processings immediately

In the Bores, Countersinks, Threads function dialogue, the Apply immediately checkbox has been added to
the lower area. If this checkbox is activated, the settings made are inserted immediately as soon as they are com-
plete. The dialogue window remains open after the settings have been applied.

#43255Bore tables

Standard processing created using the Bores, Countersinks, Threads function will also be taken into account in the
bore tables from HiCAD 2026 onwards.
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Dimensioning symbols

Reference symbol as individual function

Since the Reference symbol is used as a reference point for both the Form and positional tolerance and the Surface
symbol, a separate function has been created in the ribbon. This means that it is no longer necessary to create a
Reference symbol in the Form and positional tolerance function.

Automatic selection of arrowhead

The reference line end for Form and positional tolerances, Surface symbols and Reference symbols can now be gen-
erated automatically. The function can be activated in the Configuration Editor under Drawing > Annotations >
Form/Positional tolerance and the corresponding setting Select end of reference line automatically.

Please note:

n Note that the automatic selection does not take overlaps into account. For this reason, it is recommended to
make the change either before or after creation.

n For cylinder surfaces, an arrow is always generated, which can be processed afterwards.
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Form and positional tolerance / Surface symbol / Reference symbol leader line

The Surface symbol function dialogue window offers three options that determine how the surface symbol is dis-
played. The first option is to create the surface symbol without a leader line. The second option is to create the sur-
face symbol without a leader line by default. This means that when you click on a surface, a leader line is created.
However, if you click on an edge, the surface symbol can be placed there directly. The last option always creates the
surface symbol with a leader line.

The Form and positional tolerances function dialogue window offers three options for specifying how the tolerance is
displayed. The first option allows the tolerance to be placed freely, without a leader line or base point. The second
option allows a tolerance to be created with a base point. Finally, the last option allows the tolerance to be created
with a reference line and base point.

There are two options to choose from in the Reference symbol function dialogue window. These two options can be
used to specify whether the reference symbol should be created with or without a leader line.

Form and positional tolerance - Combine identical features for adjacent rows

If you have two overlapping tolerances with the same symbol in the Form and positional tolerances function, you can
activate the Combine identical features checkbox. This will display only one symbol at the front that applies to the
specified tolerances.
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Universal delete function for dimensioning

Several deletion functions from the 3-D Dimensioning+Text area have been combined in the Delete func-
tion. The new function can be found under 3-D Dimensioning+Text > Delete. The old deletion functions for dimen-
sions and texts can be found under .

With the new function, you can delete the following objects:

n Dimensions of any kind

n Weld symbols

n Form and positional tolerances

n Surface symbols

n Edge state

n Annotations

n Item numbers

n Reference lines

n 3-D texts

n Grid annotations

n Tables

The selected object is deleted after selection and another selection can be made. Press the ESC key to exit the func-
tion. Use the CTRL+LMB key combination to draw a rectangle in which everything mentioned above will be deleted.
You can also delete a structure using the CTRL+LMB key combination. Use the RMB to open the context menu.

There are three options available in the context menu. First, you can select Rectangle. This allows you to draw the
same rectangle for deletion as with the key combination CTRL+LMB. Via Active view, all objects are deleted from the
active view. The last selection is Drawing. With this option, all objects are deleted from the entire construction across
all sheets.

Views

Update all views with a single button

Changes have been made to the Update sectional views in active sheet/model and Update all sectional views func-
tions, as these functions now also update details, cut-outs and exploded views. The new names are as follows:

Update views for changed parts (in active sheet/model) and Update views for changed parts (in all views)

. The context menu Update views also contains the new category Recalculate developments. You can use
the two functions Active view and All views to update developments. This applies to sheet and surface devel-
opments.
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Magnetic snap-in for view functions

The following viewing functions have been extended to include magnetic snap-in:
n Views > New > New view, horizontal/vertical
n Views > New > New view, In direction of (3-D)
n Views > New > Copy 3-D view
n Views > New > Sectional view (3-D)
n Views > New > Detail view Cuboid/Sphere

Duplicating a drawing sheet

You can now create a copy of a sheet area in the ICN under Views. To do this, open the context menu and select the

Duplicate function. This can be used for both the active and inactive sheet areas. Multiple selection or selec-
tion of the model area is not possible with this function. This function duplicates everything from the selected sheet
area.
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Save part list from view

Three new functions have been added to the context menu of the views under Hide/Show parts:

n

Set current part list of the view as required part list

n

Load required part list of the view

n

Delete required part list from view

With the Set current part list of the view as required part list function, you can create a required part list from the cur-
rently visible parts. If you have added parts to the view or hidden parts, you can use the Load required part list of the
view function to call up the required part list you created. If the required part list is no longer needed, you can
remove it using the Delete required part list from view function.
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Advanced catalogue search with multiple search terms
In the Catalogue , it is now possible to specify multiple search criteria as search terms simultaneously. The search
results displayed always meet all search criteria. To include multiple search criteria in the search term, it is essential
to separate the individual search criteria with a semicolon ;.
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Cams

Cams: Filleting the corners of corner processings

The Fillet radius parameter has been added to the Cams function. This can be activated by a checkbox. Please note
that the fillet radius only affects the corner processing of the cams.
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Determine cam shape by sketch

In the Cams function, the new User-defined form option is available under Cam shape. This option allows you to use
your created sketches as cams. A sketch can be selected from the Catalogue in the Parameters under Cam shape.

The sketches you have created, parameterised with HCM and assigned variables, must be saved as KRA files in the
HiCAD folder ...\HiCAD\Kataloge\Werksnormen\Nockenformen.
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In the Catalogue Editor, under Catalogues > Factory standards > Cam shapes, create a new table using New table
with template from the context menu.

The sketch must be stored in the new table, the parameter dimensions must be specified, and the table must be
saved. The new table is now available in the catalogue of the User-defined form option.
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Cam connection – multiple cam parts during processing

A list box has been added under Parts with cams in Cam processing. First, select the part to be processed. In the
next step, select all parts that collide with the selected part due to cams. The Properties and the Corner processing
of the cut-outs can be customised for each part.
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Special dimensions according to DIN EN ISO 129-1
According to DIN ISO 120-1, special dimensions can be used to describe bore depth and countersinks. The cor-
responding standard for the annotation of countersunk and blind holes can be set in the Configuration Editor. To do
this, go to System settings > Annotations > Part annotation > Standard for annotating countersunk holes and
change the value from Standard designation according to DIN ISO 15786 to Special dimensions according to
DIN ISO 129-1.

You can also access the Settings for annotations function in the Ribbon under 3-D Dimensioning+Text > Text >
Standard designation using the arrow . There you can change the setting for the annotation of countersunk and
blind holes from According to DIN ISO 15786 to According to DIN ISO 129-1. After the change, all standard des-
ignations are updated so that the current standard is always used in the drawing. You can use the Standard des-
ignation function for countersunk and blind holes for which a special dimension is to be created.
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Improving the comprehensibility of Divide surface
To make the Divide surface function easier to understand, the names of the two modes have been changed. They
are now called Divide selected surfaces perpendicular to sketch and Divide with straight lines from points on edge of
surface. In addition, the icon for selecting the lines has been changed in the second mode. The text in the Info bar
for selecting the graphic has been changed to Select edge point of surface to be divided.
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Point clouds

Major Release

Reset clipping

The new Reset clipping function deletes all subtractions and resets the clipping to the original boundary.
This makes the entire point cloud visible. You can access this function by selecting Edit boundary and then opening
the context menu with a right-click.
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Display of point clouds
The settings for the graphical representation of the point cloud have been expanded. You now have the option to

make the following changes using the Settings function:

n Brightness: Here you can dynamically change the brightness using the slider (in increments of 0.1). The default
value is 1, which means that the point cloud becomes darker below 1 and brighter above 1.

n Improved display: This filter darkens small areas that are shaded by nearby objects. This gives the point cloud
more depth and realism.

n Emphasise edges: This filter compares the depth of each pixel with that of its neighbouring pixels to emphasise
the edges and contours of objects. This makes the shapes in the point cloud clearer. The filter is only active if
you have also activated the Improved display option.

n Blur: This reduces the contrast of the point cloud, creating smoother transitions. The filter is only active if you
have also activated the Improved display option.

The options set for the display of point clouds apply to all point clouds in the design and will be memorized when you
save your drawing.

(1) Default setting, (2) Improved display, 3) Increased brightness, improved display and emphasized edges, (4) Improved dis-

play and Blur
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The Colour mode can be selected in the Properties window (ICN) of the point cloud. In addition to the scanned col-
our, there are two additional options:

n User-defined colour mixed: With this option, the intrinsic colour of the point cloud and a highlight colour are
mixed in equal proportions. You can select the highlight colour from the system colours or drawing colours.

n User-defined colour: With this option, only the highlight colour from the system colours or drawing colours is
used.

(1) Colour mode: Custom colour, (2) Highlight colour: Green

Changed function names
For the sake of more clarity, the following function names have been changed:

Clipping Box Manager > Clipping Manager

Edit clipping box > Edit boundary
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Feature Technology

Major Release

Parameterisation of attributes without consideration of referencing settings

For the Parameterise part attributes function, the referencing settings from configuration editor under System
settings > Attribute management > Attributes are no longer taken into account. Previously, attributes with the ref-
erencing setting Do not transfer were not displayed in the selection dialogue of the function.

From now on, all attributes are displayed in the selection dialogue, regardless of the settings in the Configuration
Editor.

You can find the Parameterise part attributes function at 3-D Standard > Tools > Attr. > ....
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Automation

Discontinuation

Discontinuation of the ISD.PDM.API

Before carrying out a HELiOS update for an older HiCAD version, please note that from HELiOS 2022 omwards,
the previous ISD.PDM.API will be discontinued and replaced by the new API from Helios.Interface. If you use
customisations that use functionalities from the previous ISD.PDM.API, you must update the customisations to
the new API before carrying out the HELiOS update. If you use customisations that use functionalities from the
HiCAD API, you should ensure that the HiCAD version used is at least version 2502.5 or 2601.1 or newer. If you
are unsure whether you are using corresponding adaptations, please talk to your administrator or contact the
ISD in case of doubt.

Major Release

Favourites for dimension parameters

You can save favourites in the Dimension Parameters dialogue window. To select these favourites when
dimensioning, the HiCAD API provides the command

n DimensionSettings.Load()

Create catalogue table from template
With the HiCAD API, you can now create empty catalogue tables from existing templates. Use the command

n CreateTableFromTemplate()
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Interfaces

Major Release

Import as sub-part
In earlier versions, parts in foreign formats could only be imported into an existing HiCAD drawing as main parts.

Starting with HiCAD 2026, it is also possible to insert them as sub-parts via interfaces, for example via the context
menu of parts.

This applies to both import via Insert > Sub-part > Interfaces > 3-D Import, and via 3Dfindit.
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IFC Import

Viewer

When importing IFC files, the IFC import filter window also provides a viewer that you can use to mark individual or
multiple parts as exceptions to the import.

Move to HiCAD origin

In the past, when importing IFC files that did not contain a project coordinate system, geometries located far from
the origin in the drawing could become unmanageable in HiCAD due to the resulting loss of accuracy.

HiCAD now asks whether such geometries are present during import and displays a query if necessary.

Confirm with Yes to move the IFC model to the HiCAD zero point.

If you click No, the IFC file is imported as is without being moved.

In this context, please also note that it is generally advisable to activate the import option Transform IfcSite to origin.
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Dots in attribute identifiers

With the update to HiCAD 2026, attribute identifiers can also contain points (example: "COBie.Com-
ponent.TagNumber").

Write IFC class to pipe parts during insertion

Starting with HiCAD 31.0, the HiCAD attribute IfcType is automatically assigned an IFC class when pipe parts are
inserted. The assignment of part types to the corresponding IFC classes can be customized via the file
Install/PlantParts/IfcConfig/PartTypeIfcClassMapping.txt.

In addition, it is possible to assign an IFC class directly to a VAA/PAA. To do this, the HELiOS attribute IFC_CLASS is
added to your HELiOS database when you execute the function Update HELiOS for Plant Engineering in the
DBPlantDataImport.exe tool.

STEP Format

User-defined attributes

HiCAD supports the import and export of user-defined attributes of the STEP format.

Similar to the configuration of attributes for Navisworks export, these can be controlled via an XML file.

The imported attributes of a part or assembly can also be viewed via the interface marking of the 3-D part structure

in the ICN (right-click > Import attributes).
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You can also view the attributes via the tooltip:

Performance

A significant performance increase has been achieved for the STEP format, especially when exporting colours and
layers on a larger scale..
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Part structure of the Navisworks export and other 3-D formats
To improve the collision check when exporting to the Navisworks format, threads and sub-parts of Sheet Metal parts
are not exported as separate parts, but their geometry is included in the superordinate part or the Sheet Metal main
part.

This change also affects exports to SketchUp, VRML and Gamma-Ray formats.

In addition, referenced parts that occur multiple times are only exported and referenced once in the Navisworks
export, as is also the case with IFC exports.
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Sheet Metal

Major Release

Panel - Make thermal break switchable
During the insertion of flat panels (without offset), HiCAD 2026 or later allows you to insert either an insulation or a
continuous thermal break. The thermal break at the edge is also optional for insulations.

(1) If insulation is selected, the continuous thermal break is greyed out,

(2) If a continuous thermal break is selected, the insulation is greyed out,

(3) Insulation with thermal break at the edge

52 / 112 HiCAD 2026 - What's new?

Sheet Metal



Punch and Bore pattern

Since the Punch and Bore pattern functions have been integrated into the Bores, Countersinks, Threads

option User-defined form dialogue window, you can find the corresponding old functions at::

n Menu bar: Sheet Metal > Function group: Further Tools > Pull-down menu: Mould > Up to HiCAD 2025 >

Punch

n Menu bar: 3-D Standard > Function group: Standard Processings > Pull-down menu: Bore/Thr. > Up to HiCAD

2025 > Bore pattern .

Sheet along sketch
Previously, the New sheet along sketch function could only be used to create sheet metal parts from sketches with
degrees and circles. This restriction has been removed, so that any lines can now be used. The resulting bend zones
follow the course of the curves, meaning that they are not cylindrical. These bend zones are referred to as rolled
bend zones and are not taken into account in the allowance method. In the development, rolled bend zones do not
receive bend lines..

(1) Sheet along sketch dialogue window, (2) Feature log, (3) Automatically inserted bend zone, (4) Rolled bend zones
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Steel Engineering

Major Release

Parameterisation of article number for Steel Engineering parts
The manually selected article number for beams, profiles, sheets and plates can now also be edited using the Para-

meterise part attributes function.

Conical welded I-beams
The new function Conical welded I-beam has been added for insertion and configuration of conical I-beams. The
beams are constructed in several parts and consist of plates that are welded together. The sheets used are selected
from the catalogue. Different sheets can be selected for different components, including for the upper and lower
flanges. In addition, stiffeners and top plates can be inserted at the start and end of the beam. All components of the
beam are automatically combined in an assembly after insertion. Beam insertion is carried out in the same way as

the Insert new beam function.
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New connection: Top plate
The Top plate connection has been added to the Steel Engineering functions. This function can be used to connect
a beam via a top plate to two other intersecting beams that are perpendicular to the first beam.

Insert new beam: Select processing plane

The Insert new beam function dialogue has been expanded to include the new Select processing plane
option. This allows you to change the plane at any time during beam insertion.

Bar list: Fixed-length beams and profiles with different cutting angles
Previously, fixed-length beams and profiles with the same length were grouped together in a row when creating bar
lists, even if they had different cutting angles. Starting with HiCAD 2026, beams and profiles with the same fixed
length but different cutting angles are listed separately.
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Metal Engineering

Major Release

LogiKal interface - HiCAD information when updating processings
The Log dialogue window, which is opened by the Transfer changes in HiCAD to LogiKal function, displays the pro-
cessings that have been made. A green tick indicates that the processing will be transferred to LogiKal. If a red X is
displayed, transfer is not possible. In this case, the short description also indicates that the processing cannot be
exported. Otherwise, it notes which processing is involved. If you click on an processing in the dialogue window, it
will be highlighted in the Sheet.
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Installation Planning

Major Release

Direction of wall brackets
The Wall brackets dialogue window has been expanded to include the Direction option. You can now manually
select the upward direction Direction (Top). This option allows wall brackets to be installed when the substructure
has not been installed vertically upwards, but horizontally under the ceiling, for example.

(1) Wall plane, (2) Direction of installation
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Profile Installation

Major Release

Exact representation for roof inclinations
When installing trapezoidal sheet metal profiles with at least two roof surfaces (and at least one roof ridge), the pro-
files are now bent, provided that the installation angle allows this. The installation angle of the profile must be selec-
ted so that the length of the profile runs parallel to the roof ridge. Only profiles made of one component are bent, not
profiles with insulation. The profiles are bent at the lower edge of the material. This means that a trapezoidal profile
can be bent in the upper flange, in the lower flange or even in between, but not in the neutral axis. If the bending
point causes conflicts in a representation, a straight profile is inserted for this representation.

(1) Bent trapezoidal sheet, (2) Bending point at lower edge of material
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Plant Engineering

Major Release

Step back in part insertion
When inserting on a guideline part insertion, it was previously not possible to select a guideline other than the one
previously selected as the insertion target. To do this, you first had to switch to the part search and then back to part
insertion. For this reason, the Step back option has been added to the context menu.

Nominal diameter not written twice on guideline
The nominal diameter of guidelines was previously found in the Part attributes mask under the dba attribute Quant-
ity 1. In HiCAD 30.2, the nominal diameter was also listed under Nominal diameter, so that this value appeared
twice. This duplication has been removed in HiCAD 31.0. A conversion routine was developed to ensure that old
scenes could still be used despite the change. This involves moving the entries from Quantity 1 to the Nominal dia-
meter field.

(1) Value in two places in HiCAD 30.2, (2) From HiCAD 31.0 onwards, the value can only be found under Nominal diameter.
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Component connections

Minimum/maximum pressure

The Component connection dialogue includes the option to specify the connection option. For the Flanged con-
nection option, a function has now been added to specify a minimum and maximum pressure. Two new input fields,
Min. pressure and Max. pressure, have been added for this purpose.

This pressure value is used when searching for a suitable flange if a flange is connected to the component con-
nection.
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Connected parts for flange connection

For Component connections with flange connections, the shape of the Sealing surfaces and the type of components
to be connected can now be conveniently defined.

In addition, the AutoPlace has been expanded. If the Counter-flange checkbox is activated in the corresponding dia-
logue window, the selected components are automatically inserted.
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Revision of nozzle insertion

The Fit nozzle in vessel function has been fundamentally revised. Instead of several consecutive dialogues,
there is now a single dialogue window in which all settings are clearly summarised. The basic range of functions
remains the same, but operation has been simplified.

The new dialogue window contains the following options:

n Type of insertion: Various options are available for straight pipes (mounted, inserted projecting, inserted flush)
and elbows (mounted).

n Nozzle dimensions: The lengths Length, inner (LI) and Length, outer (LA) are specified directly in the dialogue
window. For elbows, the Elbow angle can also be defined.

n Direction: In addition to the Vertical to bounding surface setting, the Request alignment option can be used to
customise the position of the local coordinate system.

n Bore: Determines whether the nozzle geometry is deducted from the vessel wall.

This makes the installation of nozzles much more intuitive and faster, as all relevant parameters can be defined in a
single step.
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Automatic placement of guidelines: Minimum angle for elbows
Starting with HiCAD 31.0, the new option Minimum elbow angle for AutoPlace parts is available in the Configuration
Editor under Plant Engineering > Layout plan. This option allows you to specify the minimum angle at which
guidelines are automatically provided with elbows during AutoPlace.Smaller angles are instead implemented with a
mitre cut.

Write IFC class when installing pipe parts
Starting with HiCAD 31.0, the HiCAD attribute IfcType is automatically assigned an IFC class when inserting pipe
parts. The assignment of component types to the corresponding IFC classes can be adjusted via the file
Install/PlantParts/IfcConfig/PartTypeIfcClassMapping.txt.

It is also possible to assign an IFC class directly to a VAA/PAA. To do this, the HELiOS attribute IFC_CLASS is added
to your HELiOS database when you run the Update the HELiOS database for Plant Engineering function via
DBPlantDataImport.exe.
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Isometry and pipe spool drawing

Apply in the isometry update dialogue

The new Apply button has been added to the Isometry/Pipe spool drawing display and update function dialogue win-
dow. This allows changes to be applied directly while the dialogue window remains open. This means that several
elements can be updated, removed or added one after the other without having to restart the dialogue window each
time.
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Resolve 45° inclines in isometry

Sections of pipelines that run at a 45° angle to a coordinate axis can be problematic in isometric projection, as they
can obscure other pipeline sections.

For this purpose, a new option has been added to the Isometry and pipe spool drawing settings, which can be found
in the Pipe shortening tab. When creating the isometry, the affected pipe section can now be rotated by the spe-
cified angle using Resolve non-parallel overlaps so that hidden sections become visible.

Example:

The following example shows a pipeline with overlaps in Isometric projection 3, where hidden sections are made vis-
ible in the next step by resolving them.
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The following illustration shows the same line twice: once without resolving and once with resolving activated and a
rotation angle of 4.00.

(1) Example without resolving, (2) Example with resolving activated.

Please note:

n The function is not limited to pipeline constructions with 45° angles, but resolves all overlaps of non-parallel
pipes.

n The rotation angle is limited to the range –10.00 to +10.00; the prefix determines the direction of rotation.

Pipe angle only for angles not equal to 90°

By default, the %PIPE_ANGLEattribute outputs the angle of elbows and bends in bent pipelines.

The attribute %PIPE_NO_90_ANGLE has been introduced as a further addition. It only outputs a value if the respect-
ive pipe angle deviates from 90°. This allows only deviating angles to be specifically marked in drawings, while 90°
pipe angles remain unmarked.

Link views generated in the pipe spool drawing

Previously, the different views (e.g. front view, top view, side view) of a pipe in the Pipe spool drawing were not linked
to each other.

Starting with HiCAD 31.0, all views are now automatically linked to the main view, so that changes to this view are dir-
ectly applied to the other views. This simplifies the subsequent processing of the drawing.
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Symbol Editor: Structure database symbols according to classification

The Symbol Editor , located under Plant Engineering > Part Tools > Exchange > Symbol Editor, is used to edit
symbolic representations. Starting with HiCAD 31.0, the symbols in the Database branch are now automatically dis-
played in subdirectories according to their classification. This improves the clarity of the dialogue.

The main directory Database continues to display all symbolic representations in a list.
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Isometry dialogue: Behaviour of options revised

The Link document and Create new drawing options in the Isometry dialogue are now saved directly to the pipeline.
This means that the behaviour is more closely aligned with the actual specifications on the pipeline.

In the Configuration Editor under Plant Engineering > Isometry and Pipe Spool Drawing you can still store default val-
ues for Create document links and Always generate pipe spool drawing in new drawing file. These are applied auto-
matically if no specific information is available for the pipeline.

It is currently not possible to use both options in combination.
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HELiOS API

Document number via article master

Four additional virtual article attributes have been introduced that display the document number of a document
linked to an article. The attributes differ only in terms of which HELiOS link is used to determine the linked doc-
ument.

Attribute name Displayed name Viewed link

VA_LINKED_SZA Linked drawing Bauteil-Konstruktion

VA_LINKED_SPL Linked pipe spool drawing Pipeline-Spool

VA_LINKED_ISO Linked isometry Pipeline-Isometry

VA_LINKED_LAY Linked layout plan Pipeline-Layoutplan

If several documents are linked, only the document number of the first document found is displayed.

The new attributes are available in the dialogue window for annotation tags:

Alternatively, you can also use %DBAT(VA_LINKED_...).
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Catalogue Editor

Major Release

Catalogue extension: Hollow profile DIN EN 10305-3
The hollow profile DIN EN 10305-5 has been withdrawn and replaced by DIN EN 10305-3. This hollow profile has
been divided into two types and can be found in tables DIN EN 10305-3 Q and DIN EN 10305-3 R at Semi-finished
products > Beams+Profiles > Hollow profiles.
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Catalogue extension: Washers DIN 6319 C and DIN 6319 D
The standard DIN 6319 has been withdrawn without replacement, but the spherical washers and conical sockets
will continue to be used. Three tables from DIN 6319 have been added. These are DIN 6319 Form C (ball washer),
DIN 6319 Form D (conical socket) and DIN 6319 Form G (conical socket). You can find these three tables at Fasten-
ers > Washers > Washers.
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US Hollow Profiles AISC HSS RE (imperial)
Two new tables have been created at Factory standards > User-defined semi-finished products > User-defined pro-
files > Hollow profiles > Atlas Tube and a new table at ... > Hollow profiles > Sugar Steel. These contain Rectangular
HSS, Square HSS and Square Tubing.
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Self-drilling screw JT3-FR-2H-4.8
The table JT3-FR-2H has been added to Factory standards > User-defined fasteners > User-defined bolts+screws >
EJOT. Here you will find the screw of the same name.
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Alias name Flutz profiles renamed to Flutz aluminium profiles
Due to the confusion caused by the alias name Flutz profiles, this has been changed to Flutz aluminium profiles.
They can be found at Factory standards > Factory beams > FLUTZ aluminium profiles.
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Catalogue extension: EJOT self-drilling screws without sealing washers
The JT3-6-5.5 screw is also available from EJOT without a sealing washer. These screws have been added to the
catalogue. You can find these screws at Factory standards > User-defined fasteners > User-defined bolts+screws >
EJOT > JT3-6.
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Catalogue extension: Bore patterns and Punching tools
In the catalogues Factory standards > Bore patterns and Factory standards > Punching tools the tables die Tabellen
Rectangle (filleted) and Keyhole have been added.
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Implementation of Halfen HM Mounting rails and Halfen HS special bolts
The data for Halfen HM mounting rails and Halfen HS special bolts have been added to the Catalogue Editor. You
can find them at Factory standards > Series > Roof Wall Facade > Lightweight profiles > HALFEN > HM Mounting
rails and at Factory standards > User-defined fasteners > User-defined bolts+screws > HALFEN > HALFEN HS.
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Bill of Materials / Report Manager

Discontinuation of the Report Manager Professional

The additional functionality of Report Manager Professional has been integrated into the Report Manager.

Discontinuation of the "old" Report Manager

From HELiOS 2024 onwards, the "old" Report Manager, i.e. the Report Manager up to 2022, will no longer be
delivered with a standalone installation of the HELiOS Desktop. In a HiCAD/HELiOS installation or a HELiOS
update of HiCAD, however, the "old" Report Manager is still included. From HiCAD 2025 onwards, only the
"new" Report Manager as of 2023 will be supported.

Major Release

Search by alias name

In the Column settings of the Report Manager, you can search for attributes. The attribute name and descrip-
tion were taken into account. Starting with HiCAD 2026, you can also search for the alias name for the attributes.

Fixed length for Bar - Summary
In practice, beams and profiles with a fixed length and cutting angle (e.g. angle profile with a fixed length of 300 mm
and a cutting angle of 45 degrees) are often ordered. In the Bar - Summary list, all beams and profiles with the same
fixed length were previously summarised without taking the cutting angle into account. This meant that dis-
tinguishing features for ordering were lost. From HiCAD 2026 onwards, the cutting angle will also be taken into
account when summarising beams and profiles in addition to the fixed length.
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BOM-relevance of auxiliary and environment parts
Auxiliary and surrounding parts are often included in the drawing, but should not normally appear in BOMs.

If the BOM-relevance of already itemised parts is changed retrospectively, this can lead to inconsistencies in the
item numbers and texts.

For this reason, from HiCAD 2026 onwards, the procedure of creating auxiliary and surrounding parts outside the
main assembly is supported. The following changes have been made for this purpose:

In the Itemisation with options dialogue window, the Only within main assembly option has been added to the
Numbering section of the General tab.

The Only consider parts within the main assembly checkbox has been added to the General section of the Bill of

materials dialogue window.

Two default settings have been adjusted in the Configuration Editor:

n The referencing setting for the BOM-relevant attribute at System settings > Attribute management > Attributes
has been changed from "Do not transfer" to Standard behaviour.

n At Modelling > Change part structure, the Move parts out of main assembly checkbox is now enabled by default
for all industries. Previously, this was only the case for Steel Engineering.
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Configuration Management

Major Release

Apply attributes without restarting
Each time a function is started in HiCAD that offers attribute selection, the attribute list is now checked to see if it is
up to date and will be reloaded if changes have been made. This concerns

n the Attributes mask

n the Text Editor and

n the P+ID attribute assignment dialogue.

The ICN Properties window is updated when the part is changed.

During the update, the system first checks whether the HiCAD.cfgdb has been changed. If the ConfigDB has been
changed, it is reloaded.

Display of point clouds
The settings for the graphical representation of the point cloud have been expanded. You now have the option of sig-

nificantly improving the depth and realistic representation using the Settings function for point clouds. The
options set for the representation of point clouds apply to all point clouds in the design and are saved in the design
when you save it.

The default settings for new drawings can be found in the Configuration Editor at Drawing > Views > Display of point
cloud.

Revised Show/hide elements in view dialogue
In the Configuration Editor, at Drawings > Views, the "Hiding and overlapping of edges" area has been renamed to
Show/hide elements. Here you will find the default settings for the dialogue window of the HiCAD function Show/hide

elements in view from the Views menu bar. Most of the names in this area have been changed to match the
names in the dialogue. This also applies to the names found at System settings > Visualisation > Views > Insertion
view.

Switch drawing
Due to the expansion of the Switch drawing windowAD, the parameters Switch drawing window, Width and Switch
drawing window, Height (System settings > Graphic) are no longer required. You can now adjust the thumbnail win-
dows using the Ctrl key and the middle mouse button.

Reference symbol

Since the Reference symbol can be used as a reference point for both form and positional tolerances and
for the surface symbol, a separate function has been created in the menu bar. In this context, the texts of the default
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settings in the Configuration Editor at Drawing > Annotations > Form/Positional tolerances have also been aligned
with those in the function dialogue.

n Line colour > Symbol colour

n Base point symbol, Tolerance > Reference line end of tolerance symbol

n Length of base point symbol, Tolerance > Length of reference line end of tolerance symbol

n Height of base point symbol, Tolerance > Width of reference line end of tolerance symbol

n Base point symbol of reference element > Reference line end of reference symbol

n Length of base point symbol of reference element > Length of reference line end of reference symbol

n Height of base point symbol of reference element > Width of reference line end of reference symbol

Furthermore, the following settings have been added::

n Select leader line end automatically and

n Combine identical features
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Annotation of countersunk holes
You can select the standard for the annotation of countersunk and blind holes in the Configuration Editor at System
settings > Annotations > Part annotation > Standard for annotation of countersunk holes. The setting is saved
together with the drawing. For older drawings in which this setting has not yet been saved, the value is set to the
standard designation according to DIN ISO 15876.

In the 3-D Dimensioning = Text menu bar, you will find the new function Settings for annotations in the Text
function group. This allows you to change the annotation of the drawing. After a change, all tags are drawn so that
the current standard is used everywhere.

BOM-relevance of auxiliary and environment parts
Auxiliary and surrounding parts are often included in the drawing, but should not normally appear in BOMs. If the
BOM-relevance of already itemised parts is changed subsequently, this can lead to inconsistencies in the item num-
bers and texts.

For this reason, from HiCAD 2026 onwards, the procedure of creating auxiliary and surrounding parts outside the
main assembly is supported. Two default settings have been adjusted in the Configuration Editor:

n The referencing setting for the BOM-relevant attribute at System settings > Attribute management > Attributes
has been changed from "Do not transfer" to Standard behaviour.

n At Modelling > Change part structure, the Move parts out of main assembly checkbox is now enabled by default
for all industries. Previously, this was only the case for Steel Engineering.

View orientation during drawing derivation
When deriving drawings of assemblies whose part orientation was not determined manually but via the part coordin-
ate system of the main part, the front view was rotated by 90 degrees compared to the front view determined by the
part orientation. This behaviour has been corrected in HiCAD 2026.

In the Configuration Editor, at Compatibility > Automatic drawing derivation, the parameter View orientation of gen-
eral parts and assemblies has been added to maintain the old behaviour for new drawings.

Referenced parts with HELiOS article master
The following parameters at System settings > Referencing have been revised:

n Lock parts against processing if HELiOS article master is locked

If parts are to be locked against processing when the assigned article master is reserved or locked, then activate
the checkbox .

n Reserve the assigned article master when unsaved changes to a part are made

This parameter was called "Lock parts for other users via HELiOS article master" in HiCAD 2025.
If the assigned HELiOS article master of a part is to be reserved automatically as soon as geometric changes are
made, select Yes.
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Automatic or manual calculation of attributes
Depending on the settings in the Configuration Editor (System settings > Attribute management > Attribute cal-
culation), certain attributes in HiCAD, such as Weight, Surface area, Volume, Length, and Width, can be calculated
automatically. Previously, this automatic calculation setting in HiCAD could be disabled by activating the %WFIX
attribute via the Weight fixed checkbox in the Part attributes mask. The %WFIX attribute and the checkbox have
been removed. Instead, you can now set individually for each attribute in the part attribute mask for each part

whether it should be calculated automatically or entered manually . To do this, right-click on the input field in
the Part attributes mask or in the Properties window of the ICN and select Set attribute manually.

When loading old designs in HiCAD 2026, the %WFIX attribute is still evaluated and affected part attributes are set
to Set attribute manually. In configuration management, the %WFIX attribute then becomes an internal system
attribute.

Attributes for Steel Engineering
To increase user-friendliness, the descriptions of the attributes for Steel Engineering have been expanded.

AutoPlace parts on guidelines: Minimum angle for elbows
Starting with HiCAD 31.0, the new option Minimum elbow angle for AutoPlace parts is available in the Configuration
Editor at Plant Engineering > Layout plan. This option allows you to specify the minimum angle at which leading
edges are automatically fitted with pipe elbows during auto-placement. Smaller angles are instead implemented
with a mitre cut..

PRODUKTEDITORKONFIG.DAT removed
The settings from the PRODUKTEDITORKONFIG.DAT file are no longer relevant for HiCAD and HELiOS. The file is
therefore no longer available.
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Notes on HELiOS Updates

Microsoft SQL Server

The SQL Server Native Client (often abbreviated to SNAC) has been removed by Microsoft from SQL Server 2022
(16.x) and SQL Server Management Studio 19 (SSMS). It is recommended to use the latest version of the Microsoft
ODBC Driver for SQL Server instead.

Further information can be found on the Microsoft website or in the installation instructions for Microsoft SQL Server
2022.

HELiOS Workspaces: Conversion of the system directories

When updating from an older version to HELiOS 2025 (Version 30.0.0) or higher, please note that the directory struc-
ture will change. Since an automated migration is not possible, all users have to check out all data and empty their
workspaces before installing the update to avoid data loss.

In previous versions, the workspaces were located at %localappdata%. This meant that different workspaces could
be located on one system. To prevent this, the update to HELiOS 2025 will move the workspaces to the %pro-
gramdata% directory.

Checked-out files are then stored at %programdata%\ISD Software und Systeme\HELiOS Workspace\(…)*\ (*plus
Location ID and User ID). The workspace databases are stored version-dependently at %programdata%\ISD Soft-
ware und Systeme\HELiOS <Version>\Location-ID\.

Notes on update installations

For an update installation of a HELiOS version older than HELiOS 2020 (version 2500), a central update of the sup-
plied HELiOS database must be carried out..

Since conflict may occur during the update process in case of inconsistent data stocks, you should do the following:

n Data backup before updating

Make sure that a data backup was made before carrying out the update of your HELiOS database.
For the backup, either use the HELiOS Database Creator (further information can be found in the Installation
Notes) or your SQL Server Application.
In case of any questions, or if you need any help with regard to your customized system architecture , contact
the ISD Hotline.

n Log file for update

If any conflicts occur during the update, these will be recorded in the log file HeliosDbUpdate.txt (in the system
path %appdata%\ISD Software und Systeme\HeliosDbUpdate\).
Have this file ready when contacting the ISD Hotline in case of an unsuccessful update, so that they can help
you solve the problem and make a successful update.

n New mask format

Please read all notes on the new mask format introduced with HELiOS 2020 !

n MultiCAD interfaces

If you are working with a multi-CAD interface (e.g. the HELiOS-Inventor interface), please note that before
installing an update of an older version to HELiOS 2020 (Version 2500) or higher, some adjustments may have
to be made before the update.
In this case, please contact the Consulting department of the ISD Group.
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HELiOS Desktop

Major Release

Full-text search
HELiOS 2026 offers the option of integrating a Full-text search function into your PDM system.

If you have installed the full-text search on the server and client side, you can also search for and find HELiOS doc-
uments of certain file types (text, PDF, emails) using content keywords.

For this purpose the new Document full-text search dialogue window is available via Find > Full-text search > Docu-

ments , and you can also integrate the full-text search into the "regular" document search.
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With the new virtual database attributeContent relevance , the search results can then also be sorted according to
their percentage relevance to the full-text search result.

In the Admin Tools ribbon of HELiOS, you will find the function call Update search index, which you can use to ini-
tially index your HELiOS inventory data of the supported formats for full-text search and to trigger subsequent index-
ing.

The full-text search is also available in the HELiOS Internet Server user interface.
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Model structure and Document references

Document reference structure up-to-dateness

A new attribute is available for document result lists:

Document reference structure up-to-dateness (UI_ReferenceTreeIsOutdated) indicates for a document whether a
newer version of the documents referenced by the document is available.

This means that the recursive structure of the file references is considered, regardless of the document index.

For HiCAD files, for example, this means that the file version (internal KRA version number) of the referenced doc-
ument has changed since the referencing document was last saved.

When HELiOS is newly installed, the new attribute Document reference structure up- to-dateness (UI_Refer-
enceTreeIsOutdated) is shown by default.

After update installations, it is available in the attribute configuration for document result lists.

For current documents, the column entry remains empty. For outdated documents, a triangular warning symbol is
displayed:

88 / 112 HiCAD 2026 - What's new?

HELiOS Desktop

../Desktop/Benutzeroberflaeche/ergebnislisten/referenzaktual.htm


If HELiOS cannot recognise a document structure, e.g. if the user has transferred a corresponding file to HELiOS
using Drag & Drop or imported it into an existing document master, the reference up-to-dateness cannot be determ-
ined. In this case, a red question mark is displayed:
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As with other result list columns, you can switch to a view with text that displays information about the icon symbols
in the header and result list columns:
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Checking outdated documents during printing, conversion and export, as well as when changing workflow
status

In connection with the up-to-dateness of documents, the HELiOS Options for printing documents via the Spooler
and conversions, for exporting documents from HELiOS and for changing workflow status offer you advanced
options for setting how to proceed with documents that are not current or with a document currency status that is
not up to date:
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Deleting referenced articles/documents in the model structure

If you attempt to delete CAD-relevant articles from referenced structures, you will receive a warning message:

The corresponding articles are initially deselected for deletion in the selection dialogue window that opens.
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Use in articles, Use in documents
With the update to HELiOS 2026, you will find two different tabs for article use in the article detail dialogue:

n Use in articles

This refers to usage based on the product structure.

In earlier HELiOS versions, the tab was simply named "Use".

n Use in documents

This new tab lists all documents in whose model structure the active article is stored.
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Sorting the "Utilized items" result list
The option introduced with HELiOS 2025 Service Pack 2 to define sorting criteria for result lists on the Sort tab is
also available in the special product structure- and article context-related Utilized items result list.
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Convert: Further settings
In the Convert file dialogue window for documents you can now find the new Further settings... button.

By clicking on this button, you can override the conversion options specified by the HELiOS Spooler for the active
conversion process, if necessary.

The conversion to the following formats generally offers advanced settings:

n PDF (from SZA, IDW or DWG files)

n STEP (from IPT or IAM format)

n Image formats(BMP, GIF, JPG, PNG and TIFF) from Inventor files (IDW, DWG, IPT and IAM)

n STL (from IPT or IAM files)

A target format-specific dialogue window opens with the Spooler options.

For PDF files, for example, the following options are available:
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Clicking on Page margins opens a sub-dialogue box for changing the page margin dimensions

The following options are available for the STEP format:

The following options are available for image formats::

When converting to STL format, you have the following additional settings options:
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HELiOS remembers the changed settings and offers them again the next time you convert. Clicking the Reset
button at the bottom left of the dialogue window restores the default settings specified by the server.
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Export dialogue: Progress bar with context determination
In the export dialogue for HELiOS documents, the respective context (article, project, folder) is always determined in
order to build up the result list.

You will see a progress bar while this process is running.

Job overwiew
Similar to the revised interface of the HELiOS Spooler Admin Tool, the Job overview of print/conversion jobs, which
you can access in the HELiOS Desktop, has also been expanded:

There you will find corresponding buttons for controlling the jobs.

It is also possible to execute these for multiple job selections.
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HELIOS Options: Plugins

Update and save selected plugins

At HELIOS Options > Plugins, two new edit buttons have been added for managing plugins:

By selecting a plugin in the list and clicking on Update selected plugin you can perform an update without repla-
cing the plugin in the file system or by deleting and adding it again.

Here, too, you can decide in the Windows file selection dialogue at the bottom right whether you want to select only
the plugin DLL or the entire ZIP archive of the plugin for updating.

This option now also appears when transferring plugins to HELiOS.

By selecting a plugin and clicking Save selected plugin, you can save a plugin to your local system (or to a net-
work drive, for example). Multiple selection is not possible here.

Saving then exports the selected plugin and all dependent files as a ZIP archive.

This provides you with a simple way to exchange plugins between different workstations.
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Plugin directory

At the bottom of the Plugins options window, you will see the system path of your plugins integrated in HELiOS in the
row next to Plugin directory.

Clicking on Open to the right of it will open it directly in Windows Explorer.

Performance improvements for viewing
In HELiOS 2025, preview displays and viewer integrations were revised and improved. With the update to HELiOS
2026, further performance optimisations were made in this area.

When previewing IFC files in HELiOS, a reduction in main memory requirements and thus an increase in viewer per-
formance could be achieved.

A progress bar is only displayed for asynchronously started viewers – including the preview mechanisms for MS
Office files, ZIP archive viewers, and all viewers based on WebView2 – if a corresponding delay justifies it. For very
short loading times, the unnecessary, very brief appearance of a progress bar is avoided.
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HELiOS in HiCAD

Major Release

Model structure
The Model structure tab of a HELiOS document master mask displays the document structure of HiCAD files (.SZA,
.KRA). With the update to HELiOS 2026, this has been expanded to transfer and display the part structure from
HiCAD:

In addition to the icons for the respective part type, the model structure tree also displays the icons for referencing
and dependent parts.

In addition, as part of the expansion of the model structure, some interface elements have also been expanded so
that they now correspond to what you are used to in HiCAD.
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The context menu in the Model column of the Model structure results list depends on the existing context, i.e. the
respective article, document or other object (or, if applicable, no) context menu is displayed.

In addition, you can transfer the Model structure of HiCAD drawings directly from the results list to the Report Man-
ager, as you are already accustomed to doing in other areas of HELiOS.
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Important: Please note that the model structure is only transferred or updated when saving from
HiCAD to HELiOS, and therefore there may not yet be any corresponding data for existing data from
older HELiOS versions. Currently, only the model structure of the changed part structures is syn-
chronised when saving. In order to save the model structure completely for an SZA, all other
(unchanged) referenced components must also be saved manually once. For subordinate structures
for which no model structure has yet been transferred, this is indicated in the model structure by a warn-
ing icon with a corresponding tooltip.

Document reference up-to-dateness, Document reference structure up-to-dateness

Please note that adjustments to the display of document references in HELiOS result in the following changes to the
Model structure:

In the result list columns for the Document reference up-to-dateness and the Document reference structure up-to-
dateness, the column entry for current documents remains blank in the icon display. If the display With text was
chosen, the text Current is also displayed.

For outdated documents, a triangular warning symbol is displayed, or in the column display with text, Outdated is
written next to it.
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BOM-relevance of auxiliary and environment parts
Since auxiliary and environment parts are often integrated into a drawing but should not usually appear in bill of
materials, HiCAD 2026 supports the following procedure with regard to referencing, BOM-relevance and the trans-
fer of the model structure to HELiOS: to create auxiliary and environment parts outside the main assembly so that
subsequent changes to already itemised parts do not lead to inconsistencies in item numbers and texts.

The following changes have been made for this purpose:

In the dialogue window of the HiCAD function Itemise, with options , the option Only within main assembly has
been added to the General tab, in the Numbering area.

The checkbox Only consider parts within the main assembly was added to the General area of the Bill of Materials

(BOM) dialogue.

Two default settings were adjusted in the Configuration Editor:

n The referencing setting of the attribute BOM-relevant at System settings > Attribute management > Attributes
has been changed from "Do not transfer" to Standard behaviour.

n At Modelling > Change of part structure > Moving of parts out of main assembly allowed, the checkbox is now
active by default for all industries. Previously, this was only the case for the Steel Engineering module.

Virtual attributes: Document number via linked article
To output HELiOS document numbers via their link to an article, new virtual attributes have been introduced in
HELiOS that take into account the different link classes:

Virtual attribute Designation Description

VA_LINKED_
SZA

Linked drawing This attribute displays the document number of a document linked to an
article via the link class Bauteil-Konstruktion.

VA_LINKED_
SPL

Linked pipe
spool drawing

This attribute displays the document number of a document linked to an
article via the link class Pipeline-Spool.

VA_LINKED_
ISO

Linked iso-
metry

This attribute shows the document number of a document linked to an art-
icle via the link class Pipeline-Isometry.

VA_LINKED_
LAY

Linked layout
plan

This attribute shows the document number of a document linked to an art-
icle via the link class Pipeline-Layoutplan.

Please note:

If there is more than one linked document, the document number of the first document found is returned.
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You can find the new attributes in the HiCAD dialogue for annotation tags:

Hiding internal HELiOS attributes
Internal attributes are system attributes of HELiOS that are generally not relevant for end users when sorting result
lists. They are therefore hidden by default in the attribute configuration, but can be displayed by deselecting the
checkbox.

In HiCAD attribute selection masks, such as the Annotation Editor, the internal HELiOS attributes are now hidden
alongside the internal HiCAD attributes.
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HELiOS Spooler

Major Release

HELiOS Spooler Admin Tool
Mit dem Update auf HELiOS 2026 finden Sie das HELiOS Spooler Admin Tool in einer überarbeiteten Form vor.

In der neuen Benutzeroberfläche steht Ihnen ein, an verschiedene Positionen andockbares Eigenschaften-Fenster
zur Verfügung, wie Sie es etwa aus den Explorer-Bereichen des HELiOS Desktop kennen.

Auch im HELiOS Spooler Admin Tool können Sie den vollen Umfang einer Ergebnislistenkonfiguration nutzen, bei
der Sie Attribute speziell für Druckaufträge in der Kategorie Job finden.

Über die neues Ribbon-Leiste des Admin Tools haben Sie außerdem die Möglichkeit, Supportanfragen oder Fern-
wartungssitzungen zu starten, sowie Dateien in das ISD Filecenter hochzuladen:
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Improvements to the priority processing of print and conversion jobs
For conversion jobs sent by clients running older versions of HELiOS to a current version of the HELiOS Spooler,
inconsistencies could occur in the processing of a job's priority, which can generally be set by the user.

These have been fixed with the update to HELiOS 2026.
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HELiOS MS Office Interface

Major Release

Support of Office 2024
The current versions of HELiOS and the HELiOS Spooler support MS Office 2024.
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Legal notes

© 2025 ISD ® Software und Systeme GmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in accordance with
the terms of the license. The contents of this User Guide solely serve the purpose of information; it may be modified without prior notice and may
not be regarded as binding for the ISD Software und Systeme GmbH. The ISD Software und Systeme GmbH does not assume any responsibility
for the correctness or accuracy of the information provided in this document. No part of this document may be reproduced, saved to databases
or transferred in any other form without prior written permission by the ISD Software und Systeme GmbH, unless expressly allowed by virtue of
the license agreement.

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.
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Your local contact

We attach great importance to the direct contact with our cus-
tomers and partners, because only a lively dialogue and con-
stant exchange with practice ensure application- oriented
software development.

Feel free to contact us! Whether at our headquarter in Dort-
mund or at one of our branches and subsidiaries in your vicin-
ity - we will be happy to answer all your questions about our
products and services. We are looking forward to hearing from
you!

Headquarter Dortmund

ISD Software und Systeme GmbH

Hauert 4

D-44227 Dortmund

Phone +49 231 9793-0

info@isdgroup.com

ISD locations worldwide at www.isdgroup.com
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